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Lab Activity H11 
It’s a Gas and More! 
  

OUTCOMES 
 
After completing this lab activity, the student should be able to: 

 explain a simple method for distinguishing carbon dioxide gas from oxygen gas. 

 determine whether a process is endothermic or exothermic. 

 write balanced chemical equations for the reactions that occurred in this lab. 

 explain the purpose of sweating. 
 

 
 
DISCUSSION 
 
Every chemical reaction and phase change involves some sort of change in energy, though it 
may not always be apparent. This is typically due to the quantities involved or the amount of 
energy change. This lab activity looks at three processes – two chemical reactions and one 
phase change – that involve obvious changes in energy. 
 
When studying energetics, scientists define both the system and the surroundings. The system 
includes all of the substances that actually participate in the actual reaction or phase change. 
The surroundings are anything that is in the vicinity of the system with which energy is 
exchanged. The surroundings may include the flask in which a reaction is being conducted, the 
water in which the reacting substances is dissolved, or the air near the container.  
 
Most commonly, changes in the temperature of the surroundings are observed, though 
different types of energy besides heat energy may be involved (such as electrical or light). By 
observing what happens to the energy of the surroundings, one can determine what happened 
to the energy of the system. For example, if the surroundings get warmer, that means the 
system has lost energy to the surroundings. And if the surroundings get cooler, that means that 
the system has absorbed energy from the surroundings. Processes which absorb energy from 
the surroundings are classified as endothermic and processes which release energy to the 
surroundings are classified as exothermic. 
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Figure 1. The figure above shows an 
endothermic process – energy is absorbed. 
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Figure 2. The figure above shows an 
exothermic process – energy is released. 
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Here are some examples:  
 

Exothermic Processes Endothermic Processes 

Mixing household ammonia and white vinegar 
causes the temperature to increase.  

Dissolving solid ammonium nitrate in water 
causes the temperature to decrease. 

Glow sticks release light when the glow stick is 
bent and the inner solutions mix together. 

Plants absorb sunlight to convert carbon 
dioxide and water into sugar and oxygen. 

Steam from boiling water condenses on the 
skin, releasing heat and causing skin burns. 

Liquid water begins to boil and turn into steam 
when it absorbs heat from the stovetop. 

The metabolism of food provides energy for 
muscles and keeps our bodies warm. 

An egg is cooked when it absorbs heat from 
the surroundings. 

 
On a somewhat different note, the two chemical reactions that will be performed in this 
laboratory activity are gas-producing reactions. Gases commonly produced in chemical 
reactions include hydrogen, oxygen, and carbon dioxide. If one knows that these three gases 
are the only possible gaseous products of a chemical reaction, they may easily be distinguished 
by using a flaming wood splint or glowing wood splint. A flaming splint inserted into the mouth 
of a test tube or beaker containing hydrogen gas will produce a pop and/or whistling sound, 
while a flaming splint placed into a test tube or beaker containing carbon dioxide gas will simply 
be extinguished. Oxygen gas may be identified by inserting a glowing splint into the mouth of a 
test tube or beaker and observing the splint break rekindle the flames. 
 
Finally, balanced chemical equations will be written for the two chemical reactions observed in 
this lab activity. When writing the equations, remember to use proper phase labels and to ask if 
any elements may be present in their diatomic form. Look over the equation to ensure that the 
number of atoms of each element on both sides of the balanced chemical equation is the same.  
 
Example: Sodium metal reacts with water to produce an aqueous solution of sodium hydroxide 
and hydrogen gas. The balanced equation for this reaction, including phase labels: 
 
 2 Na (s) + 2 H2O (l) ⟶ 2 NaOH (aq) + H2 (g) 
 
Example: When electrolyzed, liquid water decomposes gas in the presence of a sulfuric acid 
catalyst to yield hydrogen gas and oxygen gas. The balanced equation for this reaction: 
 

 2 H2O (l)   42SOH   2 H2 (g) + O2 (g) 
 
Notice the phase labels. Water is a liquid – not aqueous, as aqueous means dissolved in water. 
Also, notice that the formula for hydrogen gas is H2, not simply H, and the formula for oxygen 
gas is O2, not O. This is because hydrogen and oxygen are diatomic elements. Note that the 
formula for sodium metal is Na and not Na+, since metals are only found in their ionic form 
when they are chemically bonded with elements that yield negatively charged ions. Lastly, 
notice that H2SO4 is written above the arrow, since it is a catalyst. Catalysts are substances that 
speed up a chemical reaction without being consumed. 
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MATERIALS (Provided By Student) MATERIALS (From Kit) 
Computer with Open USB Port 
Baking Soda (not baking powder) 

Go! Temp Temperature Probe with 
    Logger Lite or Logger Pro Software 

Hydrogen Peroxide (3%) – should be fresh , not old Electronic Balance 

Matches or Lighter Graduated Cylinder - 100 mL 
Rubbing Alcohol Plastic Cup 

White Vinegar (5%) Portion Cup 

Water Safety Goggles/Safety Glasses 

 Wood Splints - 2 Needed 
Yeast - 1 Package 

 

 
 
PROCEDURE 

 
EYE PROTECTION MUST BE WORN AT ALL TIMES DURING THIS EXPERIMENT! KEEP RUBBING 
ALCOHOL AWAY FROM ALL FLAMES! 
 

 
Part 1. Baking Soda and Vinegar 
 
1. Plug the Go! Temp temperature probe into a convenient USB port on your computer and 

launch the Logger Lite application. The temperature probe should automatically be 
identified by the software and interface. 

 

2. Under the Experiment menu, select Data Collection… Set the collection mode to “Time 
Based”, the experiment length to 180 seconds, and the sampling rate to 0.2 
samples/second (5 seconds/sample). Check the box to take a “Sample at Time Zero”. If the 
settings were correctly done, it should read near the bottom of the window, “Samples to 
be Collected: 37.” 

 
3. Turn on and tare the electronic balance. Place a portion cup onto the balance and, without 

spilling, add 2.0 g of baking soda to the cup. 
 
4. Using a graduated cylinder, add 25 mL of vinegar to a large plastic cup. 
 
5. Place the Go! Temp temperature probe into the cup containing the vinegar and allow the 

temperature readings to stabilize. To avoid tipping the cup and speed the process, the 
temperature probe may be used as a stirrer. 

 
6. Once the temperature has stabilized, click the green Collect button on the Logger Lite tool 

bar. After one or two readings have been recorded, slowly add the baking soda into the 
vinegar – slow enough to prevent the mixture from bubbling over. Stir the mixture while 
the reaction proceeds. Notice what happens to the temperature. 
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7. Once the data collection has stopped, remove the probe from the reaction mixture. If 
needed, the data collection may be stopped early by clicking on the red Stop button. 
(NOTE: When data collection begins, the green Collect button becomes a red Stop button.) 

 
8. As soon as possible and away from the top of the cup, use a lighter or match to light the 

end of a wood splint. Lower the lit end of the splint into the top of the cup containing the 
reaction mixture. The splint should NOT be lowered into the liquid, but rather into the gas 
just barely above the surface of the liquid. Note what happens to the flame. If nothing 
happens, repeat Part 1 (steps 3-4, 6, and 8) without collecting any temperature data. 

 
9. Examine the data in the table and on the graph. If satisfied with the trial, select Store 

Latest Run from the Experiment menu, so a new set of data may be graphed. If not 
satisfied, select Clear Latest Run from the Experiment menu, and repeat the reaction to 
obtain data or to retest the gas. 

 
10. Save the file before proceeding to prevent accidental loss of data. If, for whatever reason, 

the computer were to lock up, the most recently saved set(s) of data may be retrieved. 
Failure to do so may result in all data being lost in an experiment. When using the 
computer it is always a good practice to save early and often! 

 
11. Empty the contents of the cup down the drain and flush thoroughly with water. Rinse the 

plastic cup, portion cup, and probe with water and dry them off.  
 
Part 2. Hydrogen Peroxide and Yeast 
 
12. Weigh out 0.5 g of yeast into the portion cup. Using a graduated cylinder, add 25 mL of 

fresh 3% hydrogen peroxide to the large plastic cup. 

 
13. Place the temperature probe into the cup containing the hydrogen peroxide and allow the 

temperature readings to stabilize. To avoid tipping the cup and speed the process, the 
temperature probe may be used as a stirrer. 

 
14. Once the temperature has stabilized, click the Collect button. After one or two readings 

have been recorded, slowly add the yeast to the hydrogen peroxide solution – slow enough 
to prevent the mixture from bubbling over. Stir the mixture while the reaction proceeds. 
Notice what happens to the temperature as the reaction proceeds. REQUIRED PHOTO: Includes 

your face and/or clearly shows a Picture I.D. (with name), while stirring the yeast and hydrogen peroxide. The package 
of yeast and bottle of hydrogen peroxide should be visible in the photo. 

 
15. Once the data collection has stopped, remove the probe from the reaction mixture. If 

needed, the data collection may be stopped early by clicking on the Stop button. 
 
16. As soon as possible and away from the top of the cup, use a lighter or match to light the 

end of a wood splint. Allow the splint to burn for a few seconds and blow out the flame, 
leaving a glowing ember at the end of the splint. 
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17. Lower the glowing end of the splint into the top of the cup containing the reaction mixture. 
The splint should NOT be lowered into the liquid, but rather into the gas just barely above 
the surface of the liquid. Note what happens to the splint. If nothing happens, repeat Part 2 
(steps 12, 14, and 16-17) without collecting any temperature data. 

 
18. Examine the data in the table and on the graph. If satisfied with the trial, select Store 

Latest Run from the Experiment menu, so a new set of data may be graphed. If not 
satisfied, select Clear Latest Run from the Experiment menu, and repeat the reaction to 
obtain data or to retest the gas. 

 
19. Save the file before proceeding to prevent accidental loss of data. Empty the contents of 

the plastic cup down the drain and flush thoroughly with water. Rinse the plastic cup, 
portion cup, and probe with water and dry them off. 

 
Part 3. Comparative Evaporation of Liquids 
 

 
RUBBING ALCOHOL MUST BE KEPT AWAY FROM FLAMES! 
    

 
20. From the Experiment menu, select Data Collection… Change the experiment length to 60 

seconds, and the sampling rate to 1 sample/second. The box to take a “Sample at Time 
Zero” should be checked. If the settings were correctly done, it should read near the 
bottom of the window, “Samples to be Collected: 61.” 

 
21. Add water to a plastic cup to a depth of 1-2 cm. The water should be at or near (within 

±1°C) room temperature. If you are unsure of your actual room temperature, allow the dry 
temperature probe to sit out in your room until the readings stabilize. If necessary, adjust 
the temperature of the water to be within ±1°C of room temperature before moving on. 
Lower the temperature probe into the cup and allow the temperature readings to stabilize. 

 
22. Once the temperature has stabilized, click the Collect button. After one or two readings 

have been recorded, slowly lift the probe out of the water. Hold the probe upright, allowing 
a drop of water to hang from the tip of the probe. Notice what happens to the temperature 
as the drop of water evaporates from the tip. REQUIRED PHOTO: Includes the date clearly shown on a 

calendar, newspaper, cell phone, or written on a sheet of paper. Must be able to see the temperature probe with 
computer screen running Logger Lite/Pro displaying data (temperature) in the background. 

 
23. If needed, the data collection may be stopped early by clicking on the red Stop button. 

Otherwise, allow the data collection to proceed and stop on its own. 
 
24. Examine the data in the table and on the graph. If satisfied with the trial, select Store 

Latest Run from the Experiment menu, so a new set of data may be graphed. If not 
satisfied, select Clear Latest Run from the Experiment menu, and collect a new set of data. 
NOTE: If the temperature does not change, repeat the trial, ensuring there is actually a 
drop of liquid hanging from the tip of the probe. 
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25. Save the file before proceeding to prevent accidental loss of data. Empty the water. Dry 
the cup and the tip of the probe. 

 
26. Repeat steps 21-25, using rubbing alcohol in the place of water. Thoroughly flush the 

rubbing alcohol down the drain. 
 

 
 
EXTENSION 
 
Place a couple drops of water on the back of your hand. Gently blow over the surface of the 
drops. How does it feel? Dry off the water and repeat using rubbing alcohol. Do you notice any 
difference? Can you think of ways this observation may have any uses? 
 

 
 
TYPING PROPER CHEMICAL FORMULAS 
     
It is expected that you write proper chemical formulas and charges in all of your lab reports 
when formulas are written (using subscripts and superscripts). 
 
Examples: 

 Write the chemical formula for water as H2O, not H2O. 

 Write the formula for the sulfate ion as SO4
2-, not (SO4)2-. 

 Write the number 0.00074 in scientific notation as 7.4×10-4, not 7.4×10^-4. 
 

In most Windows-based applications, including Microsoft Word, the keystroke combination 
[Ctrl] + [=] turns subscripts on and off, while [Ctrl] + [Shift] + [=] turns superscripts on and off. 
Subscripts and superscripts may also be accessed from the ribbon as follows: Home > Font 
>select either X2 or X2. OpenOffice Write uses a different keystroke combination than most 
Windows applications – for subscripts, use [Ctrl] + [Shift] + [B] and for superscripts, use [Ctrl] + 
[Shift] + [P].  
 
In most Mac-based applications, [Cmd] + [=] turns subscripts on and off, while [Shift] + [Cmd] + 
[=] turns superscripts on and off. If you are using a Windows keyboard with a Mac, you need to 
assign the function of the keys. For most keyboards, the default setting is that the [Windows] 
key acts as the [Cmd] key. Subscripts may also be accessed from the menu on a Mac as follows: 
Format > Font > Subscript and Format > Font > Subscript. 
 
Within D2L, click on the pencil icon or on the answer box below to answer a question. To write 
proper chemical formulas, click on the "Advanced" tab. Clicking on the X2 icon turns on 
subscripts. Clicking on X2 a second time will turn the subscripts off. Clicking X2 toggles 
superscripts on and off. 
 
Chemical formulas and mathematical formulas should always use subscripts and superscripts 
where appropriate. 
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Name   Lab Section   
 
PRELAB QUESTIONS 
 
1. Write balanced chemical equations using proper phase labels for these reactions: 
   
 a) Iron metal with oxygen gas to produce solid iron (III) oxide, also known as rust. 
 

 

 

 

 b) Solid calcium carbonate is added to a solution of hydrochloric acid, yielding an aqueous 
solution of calcium chloride, water, and carbon dioxide gas. 

 

 

 

 

2. Identify each of the processes below as endothermic, exothermic, or neither. 
 

Process 
Endothermic, exothermic, or 

neither? 

A hydrogen balloon is ignited by a flame at the end 
of a candle, causing the balloon to explode with a big 
ball of fire. 

 

The vial inside a chemical cold pack is broken, 
bringing the chemicals into contact with each other, 
causing the pack to become cold. 

 

The process of melting ice into water.  

The process of freezing water into ice.  

 
3. A chemical reaction produced a gas. You know it must be hydrogen, oxygen, or carbon 

dioxide. How may a wood splint be used to determine the gas produced? 

 

 

 

 

 

4. Which safety precautions, if any, must be observed during this lab activity?  
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PHOTOS - Please compress photos and save your file before uploading to the dropbox. Photos 
should come close to filling the boxes below and all required items should be clearly visible. 
 

Required Photo 1: 
 

Required Photo 2: 
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Name   Lab Section   
 
DATA AND QUESTIONS 
 

Parts 1 and 2 
Baking Soda and 

Vinegar 
Hydrogen Peroxide 

and Yeast 

Initial Temperature (Before adding baking 
soda) 

  

Temperature Reached (Where it leveled off 
or came close to leveling off) 

  

Did the temperature increase, decrease, or 
stay the same? 

  

What was the change in temperature?   

Was the reaction endothermic, exothermic, 
or neither? 

  

What happened to the flaming splint when 
it was placed into the gas? 

 X X X X 

What happened to the glowing splint when 
it was placed into the gas? X X X X  

Which gas was produced by this reaction?   

 
 

Part 3 Water Rubbing Alcohol 

Initial Temperature (Before removing probe 
from liquid) 

  

Temperature Reached (Where it leveled off 
or came close to leveling off) 

  

Did the temperature increase, decrease, or 
stay the same? 

  

What was the change in temperature?   

Was the evaporation process endothermic, 
exothermic, or neither? 

  

 



 

H11.10 
 

POSTLAB QUESTIONS 

1. When finished with all of the trials: 
 

 Autoscale the graph by clicking on the Scale icon on the toolbar. 
 

 Title the graph by selecting Graph Options… from under the Options menu and entering 
appropriate text. 
 

 Add a text annotation for each of the four trials by selecting Text Annotation from 
under the Insert menu.  
 

 Drag the arrows so that each one points to a different trial on the graph. Label each of 
the trials by adding text to each of the text boxes. Drag the text boxes, if necessary, to 
make the graph look neat and organized. 
 

 Save the file for a final time after these additions. Copy and paste (or otherwise include) 
the graph in your report. 

 
 
2. Write a balanced chemical equation using the proper phase labels for the reactions 

observed in Parts 1 & 2 of this lab.  
 
 a) Baking Soda and Vinegar: Solid sodium bicarbonate reacts with an aqueous solution of 

acetic acid to produce an aqueous solution of sodium acetate, water, and the gas that 
was produced by this reaction. 

 

 

 

 

 

 

 

 b) Hydrogen Peroxide and Yeast: An aqueous solution of hydrogen peroxide decomposes 
in the presence of a yeast catalyst to yield water and the gas produced by this 
reaction. (Note: Yeast is an organism, not a chemical, so the word “yeast” may be used 
in the place of a chemical formula.) 
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3. How did you determine which gas was produced in Parts 1 & 2 of this lab? 

 

 

 

 

 

 

 

 

 

4. Explain how you determined whether the reactions in Parts 1 & 2 of this lab were 
endothermic or exothermic. 

       

 

 

 

 

 

 

 

5. Circle or underline the words in parentheses that best complete this sentence: The 
evaporation of rubbing alcohol is (more or less) (endothermic or exothermic) than the 
evaporation of water. Then explain your choices. 

 

 

 

 

 

 

 

 

6. Based on your observations in Part 3 of this lab, what is the purpose of sweating? 
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Lab Report Submission Checklist 
 
Complete the appropriate checklist and submit this page along with your lab activity. 
 
Lab Activity Submitted Via the D2L Dropbox 
 

 Prelab assignment is complete. 

 Remainder of lab activity is complete (data, questions, photos. etc.). 

 Required photos of the procedure included. 

 At least one photo shows face or photo I.D. At least one photo clearly shows the date. 

 Document filename in format of Lastname Firstname HX. 

 File size is no larger than 10 MB. 

 Only one document submitted for this lab activity. 

 Lab submitted on time. 

  If late, this is your first extension. 

 

 
 
Lab Activity Submitted Via the US Postal Service or In Person 
 

 Prelab assignment is complete. 

 Remainder of lab activity is complete (data, questions, photos. etc.). 

 
Required photos (at least one showing face or photo I.D.; at least one shows the date) of the 
procedure or a tangible artifact or product from the lab activity is included. 

 If return is desired, a self-addressed stamped envelope with sufficient postage is included*. 

 Lab submitted on time (postmarked by due date if sent via USPS). 

  If late, this is your first extension. 

 
*You may find a postage calculator at http://postcalc.usps.gov. Use the balance in your kit to 
find the weight. 
 
 

http://postcalc.usps.gov/

